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1 INTRODUCTION 

This document will highlight on how to get registered and access LSE Supplier Portal. Below 
is the checklist that needs to be followed. 

If you are a new supplier (never registered with LSE), below is the path that you need to 
follow: 

1. One-Time Registration Submission. 

2. Activation of Supplier Portal. 

3. Access to Supplier Portal. 

If you have already registered and previously have official business affairs with LSE, below 
is the pathway that you need to follow: 

1. Contact Supplier Administrator (via email/ call) for account activation. 

2. Activation of Supplier Portal. 

3. Access to Supplier Portal. 

 

2 ONE-TIME SUPPLIER REGISTRATION 

 

Supplier Registration page 

Supplier will enter the link provided by procurement admin or from LSE website. A person 
can register on behalf of the company. Supplier Registration Request should be initiated by 
vendors. 

Environment Link to register 

TEST https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/fscmUI/redwood/supplier-
registration/register-supplier/register-supplier-
verification?id=GJo4fhMYJd%2BCe75n9AqhuIz5uZ0K44LbSbbiGuQfFV1xFUxi
phLnbVhcIsOnboDg      

Table 1 - Link to access registration form 

 

Once supplier clicks at the link, the registration will be prompt below screen.  

 

Figure 1 - Supplier email verification page 

https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/fscmUI/redwood/supplier-registration/register-supplier/register-supplier-verification?id=GJo4fhMYJd%2BCe75n9AqhuIz5uZ0K44LbSbbiGuQfFV1xFUxiphLnbVhcIsOnboDg
https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/fscmUI/redwood/supplier-registration/register-supplier/register-supplier-verification?id=GJo4fhMYJd%2BCe75n9AqhuIz5uZ0K44LbSbbiGuQfFV1xFUxiphLnbVhcIsOnboDg
https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/fscmUI/redwood/supplier-registration/register-supplier/register-supplier-verification?id=GJo4fhMYJd%2BCe75n9AqhuIz5uZ0K44LbSbbiGuQfFV1xFUxiphLnbVhcIsOnboDg
https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/fscmUI/redwood/supplier-registration/register-supplier/register-supplier-verification?id=GJo4fhMYJd%2BCe75n9AqhuIz5uZ0K44LbSbbiGuQfFV1xFUxiphLnbVhcIsOnboDg


Olivestouch Technologies Sdn Bhd User Manual- Supplier Portal Module 

 

Confidential  Page 4 of 41 

 

Then the supplier will get a one-time code through the email after clicking the Access Code 
button. Enter the code, then click Continue button. 

 

Figure 2 – Access code confirmation 

 

There are 6 tabs that supplier can enter and view during supplier registration. Company 
Details, Contact, Addresses, Business Classification, Bank Accounts, Product and Services. 

 

 

Figure 3 – Supplier Registration  
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Company Details 

 

In this field, supplier need to enter company information for example Company name, Tax 
Organization Type, Supplier Type and corporate website. After supplier fill up all the 
information and submit the registration, Procurement admin will verify the request. Supplier 
will receive email notification to reset password and link to the system after approved by 
procurement admin. 

 

No. Steps 

1.  Navigate to link provided. 

2.  Fill in the fields for Company Details 

 

3.  Enter Company, Tax Organization Type, Supplier Type. 

4.  In the Additional Information area supplier need to enter information as below: 

Company Reg-Date = Date of Company Establishment. 

Company Registration No. = unique identifier assigned to a company when it is incorporated or 
registered with the relevant government authority. 

Equity of Bumiputra%, Equity of Non Bumi%, Equity of Foreigner% = percentage of employee 
ethnicity in the company. 

Status = Designation related to the ownership and control of companies in Malaysia. 

Owner of Company 1/New ID No and Owner of Company 2/New ID No = Details of the 
company’s owner. 

Type of Work = Free Text field. Supplier can enter services/ product name in this field. 

5.  For e-Invoice related supplier, you must indicate related information for TIN, MSIC Code, e-
Invoice Email and Self-billed Supplier.  

6.  Supplier can also provide Corporate Web Site, Attachments and Note to Approver if any. 
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7.  Click Next to continue to contact sections 

8.  The Save for Later functions allow vendor to continue the registration later. The link to 
continue the registration process will be sent to the registered email at the first step. 

Table 2  Company Details 

 

Contacts 

 

On the contacts tabs supplier can define the contacts. Supplier can use the contacts to 
capture name, job title, email IDs. 

 

No. Steps 

1.  Contact details filled in Company Details will be auto populated. 

 

2.  Suppliers need to enter First Name, Last name, Email and other contact information. 

3.  Attempt the option for Administrative Contact and user account. Tick Administrative Contact 
to appoint the user as main point of contact for vendor registration matters. Tick Create user 
account to request individual sign in for the user and assign specific system roles.  

The roles for the contact supplier can choose related to the contact information. If else, just left 
the default assigned roles. 

4.  

Click ‘ ’ button to create additional contact if any. 

5.  Click Next to continue to Address sections. 

Table 3 Supplier Contact Details 
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Addresses 

 

Supplier can create Supplier Address in the Addresses tab, Tick on Ordering, Remit to and 
RFQ or Bidding on the Address Purpose. Supplier can also capture the phone number, fax 
number, email ID.  

 

No. Steps 

1.  Click on Addresses section  

2.  

 

3.  Fill in the Address Name. Kindly use format e.g: Company initial – CityName (XXX-Subang) 

Fill in the rest of the fields. 

4.  Tick the address purpose that related to the address. 

5.  Tick the contact information that is related to the address.  

6.  Click Next to continue to Business Classifications section. 

Table 4  Supplier Address Details 
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Business Classifications 

 

Supplier can attach attachment and their certificate in this tab. Supplier need to choose 
business classification from the drop-down list are applicable to the company. Start date and 
expiration date for the attachment need to be entered to initiate the expiration date for the 
certificate. 

 

No. Steps 

1.  Click on Business Classifications section  

2.  Select the ‘List of Value’ selection to add certification that related you the company 

3.  Select the business classification from the drop-down list. 

 

4.  Fill in the rest of the fields. 

Enter Start Date and Expiration Date. 

 

5.  Drag and drop the file from your local computer file into the screen to attach the file. 

6.  
Click  button to add more certificates 

7.  Click Next to continue to Bank Accounts section. 

Table 5 Business Classification Details 
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Example of Certification 

 

No. Certificate 

1. Suruhanjaya Syarikat Malaysia (SSM) 

2. Certification of Sole Agency 

3. Ministry of Finance Malaysia (MOF) 

4. Bahagian Pembangunan Kontraktor & Usahawan (BPKU) 

5. Lembaga Pembangunan Industri Pembinaan Malaysia 
(CIDB) 

6. Jabatan Keselamatan Dan Kesihatan Pekerjaan (JKKP) 

7. Suruhanjaya Tenaga (ST) 

8. Suruhanjaya Perkhidmatan Air Negara (SPAN) 

9. Borang 9/17 

10. Borang 24/78 

11. Borang 49/14 

12. Borang D/E 

Table 6 Sample of Certificate 

 

Example of Attachment 

 

No. Attachment 

1. Latest Audited Financial Statement 

2. Bank Statement 

3. Organization Chart 

4. Company Profile 

5. Registration Fee 

Table 7 Sample of Attachment 
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Figure 4 Business Classification Expiring at Requiring Attention 

 

 

 

Figure 5 Business Classification Expiring Screen 
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Bank Accounts 

 

Suppliers need to enter Bank Account information. This information is required for invoice 
and payment processes. 

 

No. Steps 

1.  Click on Bank Accounts section  

2.  Fill in info Country, Bank, Branch and Account Number. 

 

3.  
Click  to add more bank account information 

4.  Click Next to continue to Product and Services section. 

Table 8 Bank Account Information 

 

 

Notes:    If the supplier's registered bank is located outside of Malaysia, they may not be 
able to select the bank name from the provided list of values. In this case, the supplier 
should include their bank account details in the business classification tab and submit the 
account information along with a 3 to 6-month bank statement. 
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Product & Services 

 

Kod Bidang is required information need to be fill up during supplier registration. 

This is to identify which services the company offered. 

 

No. Steps 

1.  Click on Product and Services section  

2.  Click Select and Add to add a product or services that you offer. 

 

3.  Suppliers can choose based on Category Name and Description define. 

Tick the line item you wish to add. You can review the selections by clicking ‘View Selected’ 
and ‘Clear Selected’ button. 

 

4.  Click Submit to continue to submit the application. 

5.  Supplier will get application confirmation and application number after success submission. 

 

Table 9 Product and Services Information 
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After submission is completed, the supplier will get email notification whether the application 
was approved or rejected.  

1.  

  

Supplier will receive email notification regarding registration approval status. 

2.  Then, supplier will get another email that you will be assigned access to the supplier portal as 
below: 

 

 

Supplier needs to access the portal to reset the password for the first-time. 

 

3.  Supplier will receive password reset confirmation. 

 

 

4.  Supplier login and able to enter supplier portal. 
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Table 10 Supplier Portal Activation 
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3 GETTING STARTED 

This section provides start-up instructions for using the Oracle applications. 

 

3.1 Sign-On to Cloud applications  

To log into the application:  

1. Open internet browser window. 

2. Enter the below URL:  

 

Environment Link for Supplier Portal login 

TEST https://login-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/  

PROD https://login-etei-saasfaprod1.fa.ocs.oraclecloud.com/  

Table 11 Direct Login URL 

 

3. The Sign In page appears. Enter your User ID and Password.  

 

Figure 6 Oracle Cloud Sign-In Page 

 

4. Your user ID and password are case sensitive. Passwords always appear as 
asterisks in the display as you enter them.  

5. Tab to or click the  button to sign in. 

6. Personal Homepage dashboard screen appears with CLOUD privilege access. 

 

3.2 Navigating from Personal Home Page to Applications 

 

https://login-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/
https://login-etei-saasfaprod1.fa.ocs.oraclecloud.com/
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After you log in to Oracle Applications, your Oracle Procurement Cloud Home page is 
displayed. All the functionality within the Oracle Cloud applications revolves around 
homepage which you can personalize. From here you can: 

 

1.Get a quick glance at your work-related conversations and announcements. 

2.Use the Application Link icons to navigate to pages and dashboards to perform your day-
to-day activities.  

3.Access the Navigator to access any additional applications that are not available in the 
application section on the home page 

4. Favourited list of quick actions to quickly perform some key tasks. 

 

Note: The exact appearance of your windows may vary depending on your personalization 
and roles that is assign to you. 

 

Figure 7 Personal Home Page 

 

 

 

 

 

 

 

 

 

Once you have set your homepage as the Newsfeed Home Page, then it will come with 
different sections. 

 

1. Apps Section.  

Navigator Home Watchlist 
Settings
& Action 

Logo Favorites & recent item Notification 

Figure 8 Navigation tools in the global area of the home page 
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Figure 9 Apps section 

 

Within the Apps section, you have various icons that can be used to start navigating into 
the different work areas of an application. For example, if you would like to navigate to 
the Invoices work area within Payables, you will select your application as Payables. And 
you will choose Invoices in the Apps section. When you select Invoices, the system 
takes you to the Invoices work area, where you can perform various activities, such as 
recording invoices, managing invoices, generating accounting for your invoices, etc. 
Once your work has been completed, you can go back to the home page by using the 
home icon. 

You can also access the apps via the Navigator.  

Here, the access is granted to various work areas based on the roles that have been 
given to your user account. You have the flexibility to personalize the App section. You 
can decide what you want to show within these springboard icons and what you want to 
hide. If you are an order regular visitor to the Payment work area, you mostly work with 
Payable’s dashboard invoices, you can hide the payments by clicking on this icon. So, it 
will not be shown in the apps icon but only accessible through the Navigator. 

 

 

 

2. Things to Finish section.  

 

Figure 10 Things to Finish section 

 

The Things to Finish section provides you with a count of any pending notifications that are 
assigned to you and may require an action from you. Account Link name created by me lists 
the approval requests that you have created. You can click the link to navigate to a full list of 

Click this to 
personalize 
springboard 
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notifications pertaining to that account. Then the items listed in the Things to Finish section 
are same as the notifications that are listed in the global header.  

The same information is available when you click on notifications icon. You can access the 
same number of notifications from here, as well as from the Things to Finish section. The list 
displays the latest notification first and allows you to scroll horizontally to view more 
notifications.  

You can clear a notification from the list by clicking the Close icon. When you clear a 
notification, the count does not change, since no action is taken on that notification. If you 
click on you will get a listing of all the notifications that are either FYI or the notifications that 
require an action from you. When you click on the link it opens the notification, and you can 
get the details of the notification. If you are satisfied, you can either approve it or you can 
either reject it. Once the notification is read then the count will change. 

 

3. Analytics section 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Figure 11 Analytics section 

 

 

As far as procurement is concerned, there are currently few choices of analytics 
display. And they are source to settle infolet, service infolet, innovate to 
commercialize infolet, plan to produce and order to cash infolets. You can 

Click on this icon to either 
hide or display a particular 
infolet. 

Infolets 
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personalize the Analytics section and decide which infolet should be visible, which 
should not be visible.  

 

3.3 Creating Favorites and Setting Preferences  

 

Creating Favorites 

Each user has their own favorites and adding favorites is easy in cloud: just go to your 
favorite work area or task page. Click on the favorite icon and click Add to Favorites.  By this 
you get to your favorite pages directly and easily when you click the favorite icon. You can 
remove unwanted pages by clicking Manage Favorites. 

 

  

Figure 12 Creating and Managing Favorites 

 

Set Preferences 

Select Preferences to set personal options such as regional, language, accessibility setting, 
watchlist, etc as shown in the list in Figure 8. You can also reset your password from the 
Preferences page. To get into set preferences, click on setting and action dropdown menu 
click on Set Preferences. 
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Figure 13 Setting Preference 

 

3.4 Overview of Using Work Areas to Streamline Business Processes 

 

Use work areas to gain instant insight into your business and identify potential problems with 
processing transactions.  

Work areas can include the following: 

 

• Infolets 

• Content area 

• Action toolbar 

• Tasks panel tab 

• Process Warnings and Errors  

• Bank Statement Reconciliation 

• Process Monitor 

 

 

 

Figure 14 Budgetary Control Work Area 

Infotiles 

Summarize a high volume of transactional information. You can quickly identify potential 
problems and prioritize your daily activities by scanning the infotiles and accessing 
transaction details. 

Task Panel 

Content area 

Process Monitor 
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For example, select an infotile to display corresponding transactional information in the 
content area. You can also click links in the infotile to filter the records in greater detail in the 
content area. 

 

Content Area 

The content area displays transactional information related to the infotile you select. You can 
review the detailed information and take the necessary action. 

For example, click the item link in the table to drill down to transaction-level information. You 
can perform multiple actions on the transaction, such as editing, approving, or rejecting the 
transaction, and posting the transaction to the ledger. 

 

Actions Toolbar 

Use the actions toolbar to perform a range of activities on one or more rows you select in the 
content area. 

 

 

For example, select a transaction row and use the View menu to view the transaction in 
more detail. You can export the data to an Excel worksheet, detach the pane, approve, or 
reject one or more transactions, as well as apply additional filters. 

 

Tasks Panel Tab 

The Tasks panel includes tasks that are related to the work area and that you have access 
to perform. 

For example, create an invoice, review journal entries, create mass additions, and manage 
accounting periods within a task panel. 

 

Process Warnings and Errors 

The process warnings and errors keep previous processes history that has been run for 
bank statement loader. This area contains purge function which is available to delete error 
files. 

For example, select on the file then click on  button to purge and completely terminate 
the files. 

 

Bank Statement Reconciliation 

The bank statement reconciliation will provide an information of bank statement and its 
status on reconciliation. There will be two tabs which are Incomplete and Complete. 

For example, Incomplete tab listed all bank statement that consists of statement lines which 
have not yet to reconcile while Complete tab listed bank statement which have been 
completed reconciled. 
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Process Monitor 

The Process Monitor is to monitor schedule process. 

For example, instead of navigating to Scheduled Processes Task, you may use the refresh 
button to keep update on the process item.  It will provide you the same info as in Scheduled 
Processes Page. 

 

3.5 Scheduled process 

 

Scheduled processes do tasks that are too complex or time-consuming to do manually, for 
example importing data or updating many records. You can run scheduled processes on a 
recurring schedule and send notifications based on how the process ends. Some scheduled 
processes give you printable output. Those processes might have Report in their name. 

 

 

 

Jobs  

Each scheduled process that you run is based on a job. The job is the executable that 
controls what the process can do and what parameters and other options you have for the 
process. A job set contains multiple jobs. 

Job definitions can be set on Oracle Business Intelligence Publisher reports so that people 
can run the reports as scheduled processes. 

 

Process Sets 

A process set is a scheduled process that is based on a job set. So, when you submit a 
process set, you are running more than one job. 

 

Note: When you submit certain scheduled processes, the job logic causes other processes 
to automatically run. But in this case, you are not submitting a process set that includes 
those other processes. 

 

Submission 

When you submit a scheduled process, you can use its parameters to control which records 
are processed and how. Some scheduled processes do not have parameters. 

As part of the submission, you can also set up a schedule for the process, for example to run 
once a week for two months. Every time a process runs, there is a unique process ID. 

 

Output 

Some scheduled processes provide output in PDF, HTML, and other formats. For example, 
a process can import records and produce output with details about those records. There are 
many types of output, for example a tax document or a list of transactions. 

 

Process Sets 
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A process set is a type of scheduled process that is based on a job set and contains at least 
two processes. So, you can run many processes in one go, for a specific purpose. These 
processes run in a certain order, in serial or parallel, or by some other logic.  

Process sets can have any number of individual scheduled processes and even other 
process sets.  

 

To Submit Scheduled Processes 

 

Click Navigator > Tools > Scheduled Processes. 

 

 

 
1. On the Scheduled Processes Overview page, click Schedule New Process. 

2. Leave the type as Job, enter the process that you want to submit, and click OK. 

3. In the Process Details dialog box, enter at least the required parameters, if any. 

 
Some processes have no parameters at all. Some parameters depend on other 

parameters. For example, date range parameters might appear only after you select 

By Date for another parameter. 

 
4. Click the Advanced button if you want to define the schedule, notifications, or 

output. Continue to the next steps. Or just skip to the steps for  

5. Click Submit, to run the process once as soon as possible with the default output. 

 

Define the Schedule 

Set up a schedule to run the process on a recurring basis or at a specific time. Use the 
Process Details dialog box in Advanced mode. 

 
1. Open the Schedule tab and select Using a schedule for the Run option. 

2. Select a frequency. 

3. Select User-Defined if you want to enter the exact dates and times to run the 

process. 

4. You can select Use a Saved Schedule to use an existing schedule if there are any. 

5. Depending on the frequency, define when the process should run. 

Define the Output 
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You can choose the layout, format, and destination for your output. Use the Process Details 
dialog box in Advanced mode. 

 
1. Open the Output tab, if available. 

2. Click Add Output Document. 

3. Change the name if you want. The name identifies this output document when you 

go to view output later. 

4. Select a layout if you have more than one to choose from. 

5. Select a format, for example one of these: 

 
PDF: Is the best option if you want to print the output. 

Excel: Supports embedded images, such as charts and logos, but can be opened 

only in Excel 2003 or higher. 

Data: Gives you report data in an XML file, which is used mainly for editing the report 

layout. 

 
6. Click Add Destination to send the output somewhere, for example to a printer or 

email address. You can add many destinations and send the output to all of them at 

the same time. 

 
Tip: You can also print the output as part of the steps for finishing the submission, 

instead of adding a printer destination here. 

 

To add more output documents, repeat steps 2 to 6. 

 

Set Up Notifications 

You can have notifications sent out depending on how the process ends. Use the Process 
Details dialog box in Advanced mode to set that up. 

 
1. Open the Notification tab. 

2. Click Create Notification. 

3. In the Recipient field, enter the user ID of the person you want to send the 

notification to. 

4. In the Condition list, select when to send the notification, for example when the 

process ends in error. 

5. Click OK. 

 

To send notifications to more people, repeat steps 2 to 5. 

 

Finish the Submission 

Follow these steps in the Process Details dialog box: 

 
1. Click the Process Options button if you want to define settings that affect the data to 

be processed. 
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2. If the process gives you output and you want to print it, select the Print output check 

box and a printer. 

3. Select the Notify me when this process ends check box if you want to get an email 

notification. 

4. Enter submission notes to capture any information you want to associate with this 

submission. You can use your notes to find this submission later. 

5. Click Submit. 

6. Click OK to confirm. 

 

Tip: Note down the process ID for your submission so you can easily find it later. For 
example, let's say you set the process to run once a week. If you later want to cancel all runs 
on this schedule, you need to cancel this original submission with this process ID. 

 

To Submit Process Sets 

 

To submit a process set from the Scheduled Processes Overview page: 

 
1. Proceed with the steps that you would follow to submit any scheduled process, but 

select Job Set for the Type option. 

2. In the Process details dialog box, set parameters for individual processes in the set. 

A process set itself does not have parameters. 

a. Select a process on the Processes tab. 

b. Enter parameters for that process, if any. 

c. Repeat for other processes in the set. 

3. Define the schedule, output, and notifications for the process set, as you would do for 

any scheduled process. 

4. Set any other options and click Submit. 

 

To Check Status 

 

1. Click Navigator > Tools > Scheduled Processes. 

The Search Results table shows processes that match the default saved 
search, Last 24 hours. 

• The table might be blank if nothing was submitted. 

• If submission notes were entered when submitting the process, you can use 
the Submission Notes column to help identify the process. 

 

 

2. If you don't see the process, click the Refresh icon or use the Search section. 

3. Do any of these tasks to check on the progress of the process: 

• For more details about the status, click the status link. For example, if a process 

is in the Ready status, you can click the Ready link in the Status column to see 

where the process is in the submission queue. 
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• Check the Start Time column to see if the process has started running yet. 

• In the Search Results table, find the This Job's Items Processed / Errors / 

Total column. For some scheduled processes, this column shows what's getting 

processed and how things are going.  

• Click the View Log button, especially if your process has a blank This Job's 

Items Processed / Errors / Total column. The type of information in the log 

varies, depending on the process. You can open the log from here only for if the 

process is currently running. When the process is done, you might want to also 

take a look at the final log, if any, from the Details section. 

To view output from scheduled process 

 

1. Click Navigator > Tools > Scheduled Process. 

2. Find your scheduled process and, if you need to, refresh the search results to see 
the latest status. 

3. Select the scheduled process. 

4. Go to the Output subsection in the Details section. 

5. Click the link in the Output Name column to view or download the output, which you 
can then print. 

6. To view or export the output in a different format: 

a. Click the Republish button. 

b. Click the Actions icon. 

c. Select Export, and then select a format. 
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4 MANAGE VENDOR PROFILE 

 

No. Work Area Navigation 

1.  Supplier Portal Supplier Portal 

Table 12 Navigation 

 

 

Figure 15 Supplier Portal Screen 

 

 

No. Steps 

1.  Go to Task. 

Click Manage Profile. 

Supplier able to view the company information, requiring attention, recent activity and 
transaction reports. 

In this page, supplier also can view Supplier News publish by LSE Team. 
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2.  Click Edit button. 

 

3.  Click Yes to submit a change request for your profile. 

 

4.  Fill in the Change Description field. 

(Example: Adding category as there are additional certificate) 
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5.  Click the relevant tabs to update the information (Example: Contact, Addresses or Products 
and Services) 

 

6.  Click Select and Add or ‘+’ button to add item. 

7.  Example of inputs. 

Tick the line item you wish to add. 

Click Apply to add the selected category and search another product. 

Once all the categories are added, click OK. 

 

8.  Click Review Changes to see the changes made. 
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9.  Supplier can Delete Change Request if don’t want to proceed the changes. 

 

10.  Supplier can review the details before submit. 

Click Submit to send the change request for approval. 

 

11.  A pop-up window will appear to notify that the change request has been submitted for 
approval.  

Click OK to close the window. 

 

12.  Once Procurement Admin has reviewed the request, you will receive a notification on the 
change request outcome. 

 

 

Table 13 Edit Supplier Information 
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5 VIEW PURCHASE ORDER 

 

No. Work Area Navigation 

1.  Supplier Portal Supplier Portal 

Table 14 Navigation 

 

 

Figure 16 Supplier Portal Screen (Purchase Order) 

 

 

No. Steps 

1.  Go to Task. 

Under Orders section, click on Manage Orders to view Purchase Orders 
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2.  Fill in the fields to search for a particular Purchase Order. 

Click Search button. 

 

3.  Refer to Status field for PO status. 

Check the PO details, click on the Purchase Order Number hyperlink. 

 

4.  Click View Details to view Ordered, Received, Delivered and Invoiced. 

 

5.  Refer to Received column to view the amount GRN by requester. 

 

Table 15 Manage Order Screen 
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6 SUBMIT INVOICE IN SUPPLIER PORTAL 

 

No. Work Area Navigation 

1.  Supplier Portal Supplier Portal 

Table 16 Navigation 

 

 

Figure 17 Supplier Portal Screen (Invoice) 

 

 

No. Steps 

1.  Go to Task. 

Under Invoices and Payments section, click Create Invoice 
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2.  Select Identifying PO. 

Choose your desired Bank Account in the Remit to Bank Account field. 

Fill in the Invoice number in the Number field. 

Select the date of invoice. Invoice number cannot be backdated. 

Click the ‘+’ button to attach the Invoice and GRN document. 

 

3.  To upload a document, click Choose File. 

Fill in the Title and Description fields. 

Click OK. 

 

4.  

Under Lines section, click the select and add button to add purchase order line. 

Matching the invoice to the purchase order line is important to ensure smooth payment 
process. 

 

5.  Purchase Order number will be automatically display. 

If no lines appeared, the PR requester has yet to perform GRN. 

Highlight the relevant purchase order line. If multiple PO lines appear, select the lines based on 
your invoice. 

Click Apply. 

Click OK. 
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6.  

 

Click Save. 

To submit the invoice, click Submit. 

7.  Click OK to close the pop-up window. 

8.  Click Printable page if you would like to download a copy of this invoice for your reference. 

9.  Click Create Another to submit another invoice. 

10.  Click Done to exit the page. 

Table 17 Create Invoice 
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7 VIEW INVOICE AND PAYMENT IN SUPPLIER PORTAL 

 

No. Work Area Navigation 

1.  Supplier Portal Supplier Portal 

Table 18 Navigation 

 

 

 

Figure 18 Supplier Portal Screen (Invoice & Payment) 

 

No. Steps 

1.  Go to Task. 

Under Invoices and Payments section, click View Invoice 

 

2.  Fill up relevant information at parameter screen. 

Click Search button. 
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Supplier can refer to Invoice Status . 

The Payment Number will appear once invoice payment has been made. 

 

Table 19 View Invoice & Payment 

 

 

8 CREATE RESPONSE IN SUPPLIER PORTAL 

 

No. Work Area Navigation 

1.  Supplier Portal Supplier Portal 

Table 20 Navigation 

 

 

Figure 19 Supplier Portal Screen (Create Response) 
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No
. 

Steps 

1.  Go to Task. 

Under Negotiations section, click Manage Responses. 

 

2.  Fill up relevant information at parameter screen. 

Click Search button. 

Open the Negotiation number. 

 

 

3.  Click Create Response. 

 

4. Enter Create Response Information 
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5.  Click Next Button 

6.  Go to the section field   

 

 

7.  Click Next Button 

8.  Enter Response Price 

 

9.  Click Next Button 

10.  Review Response and Submit 



Olivestouch Technologies Sdn Bhd User Manual- Supplier Portal Module 

 

Confidential  Page 40 of 41 

 

 

11.  

 

Click Yes Button 

Table 21 Create Respond 
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